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Preface

Revision History

1.0 Initial release of document for Release 2021.1.0 September 2021

About this Guide

This guide informs you about the APIs to be used for executing different Cert+ Automation workflows.

Audience

This guide is intended for CISO, PKI Security, and Application Teams.

Text Conventions

The following text conventions are used in this document:

boldface Boldface type indicates graphical user interface elements associated with

an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for

whichyou supply particular values.

codeblock Indicates commands within a paragraph, URLS, code in examples, text

thatappears on the screen, or text that you enter.

Copyright © 2021 AppViewX, Inc. All Rights Reserved. 4



Chapter 1: Prerequisites

The following table describes the web browser requirements to create and execute workflows as well as

tasks.

Web Browser Requirement

Internet Explorer [ v11.0.9600.18817 or later

Firefox V74.0.1 (64-bit) or later

Google Chrome |V85.0.4183.83 (64-hit) or later

Copyright © 2021 AppViewX, Inc. All Rights Reserved.



Chapter 2: Role-Based Access Control

With role-based access control (RBAC), you can assign permissions to users for accessing the module
and allow/restrict them to perform certain actions. You can refer to this link and find out more about

RBAC.

Copyright © 2021 AppViewX, Inc. All Rights Reserved.


https://adminguide.appviewx.com/configuring-the-role-and-resource-based-access-control-rbac

Chapter 3: Accessing CERT+ Automation Workflows
The CERT+ Automation workflows are available on the Workflow Catalog page.

To view these workflows:

1. Log into AppViewX with valid credentials.

appviewX

2. To access the navigation pane, hover the mouse over = .

3. From the menu displayed, click Request.

Copyright © 2021 AppViewX, Inc. All Rights Reserved.
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Accessing CERT+ Automation Workflows

The Workflow Request page is displayed, with the Overview section open by default.

Copyright © 2021 AppViewX, Inc. All Rights Reserved.



Accessing CERT+ Automation Workflows
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4. On the Workflow Request page, from the navigation menu on the left, select View/Run.

The workflow Catalog page is displayed.
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5. On the Catalog page, under the Certificate Lifecycle Automation category, click
6. From the options displayed, select Full View.
9
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Accessing CERT+ Automation Workflows

Catalog
Overview
Custom reports |_-C_e1tiﬁn:ate Lifecycle Automation :.
9 e O

{Full View |
View/Run

» (Certificate Expiry Notification based on Cert...

Scheduled jobs

* Certificate Expiry Notification - Cert Group ...
* Certificate Expiry Notification - Days

* Certificate Expiry Notification - Devices | Se...

~
0 Tip: You can also search for a workflow on the Catalog page by typing the keyword(s) in the

search bar.

Copyright © 2021 AppViewX, Inc. All Rights Reserved. 10



Chapter 4: Certificate Expiry Workflows

* Overview

» Certificate Expiry Notification based on Certificate Attributes
* Certificate Expiry Notification - Cert Group Hierarchy

» Certificate Expiry Notification - Days

* Certificate Expiry Notification - Devices | Servers

» Certificate Expiry Notification

» Update Certificate Attributes

» Certificate Expiry Notification with JIRA

* Certificate Expiry Notification with ServiceNow

» Orphan Certificates Report

Overview

This section lists and describes the workflows that can be used to notify the user(s) about the expiry of
the certificates based on different criteria such as certificate attributes, expiry period, hierarchy, and so

on. It also enables you to create tickets for expiring certificates on Jira/ServiceNow.

Certificate Expiry Notification based on Certificate Attributes

This workflow allows you to send an email notification listing certificates expiring in a specific number of

days with selected certificate attribute details displayed in the email.

To trigger this workflow:;

1. On the Workflow Request page, from the navigation menu on the left, select View/Run.

The workflow Catalog page is displayed.

Copyright © 2021 AppViewX, Inc. All Rights Reserved.
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Certificate Expiry Workflows
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2. On the Catalog page, under Certificate Lifecycle Automation catalog, click

3. From the options displayed, select Full View.

4. In the Certificate Lifecycle Automation window, under the Alert and Notification category, hover

your mouse over the Certificate Expiry Notification based on Certificate Attributes workflow and

click * .

& Cartifate Expiry Notration

* Cenficats Expiry Nostfication based en et . D

Runi
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= [Enroll Certificate with Certificate Group and
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= Qwphan Certificaces Report

s it 1B

[o Tip: You can also search for the workflow by typing the workflow name in the search bar.

The workflow is executed with the workflow inputs requested at the first stage.
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Certificate Expiry Workflows

> A Abcat s Workfhon -

A Catifiats Bapiry

A Watific acean

5. Under the Certificate Expiry section, enter or select the field information as shown.

» Certificate Expiry

* Time Frame Type Exact v
* Expiry Time Period ®
Report Fields None Selected -

The following table describes the fields under the Certificate Expiry section:

*Time Frame Type Enter the time frame type from the available options:

» Exact - The system generates a report of certificates that expire on
exactly the number of days as mentioned in the expiry time period
starting from today. For example, if you mention 30 in the Expiry Time
period on the 1st day of the month, the report will contain details of
certificates expiring on the 30th day of the month.

* Range - The system generates a report of certificates that expire within

a range of days as mentioned in expiry time period. For example, if the

Copyright © 2021 AppViewX, Inc. All Rights Reserved. 13




Certificate Expiry Workflows

range is mentioned as 30-60 on the 1st day of the month, the system
generates a report of certificates expiring from 30th day to 60th day
from that day.

*Expiry Time Period Enter the expiry time period for which notification has to be sent. Multiple

values can be entered, separated by commas. You can either define it

as an exact number or a range or a combination of both. For example,

30,60,90 or 0-30,30-60,0-60 or 30,30-60,90.

« Input type: Range - The expiry report will be generated for the range
specified. For example, 0 - 30 days, 0 - 60 days, 0 - 90 days.

« Input type: Exact - The expiry report will be generated for certificates
expiring on the exact specified date. For example, certificates expiring
on the 30th, 60th, 90th day.

Report Fields Select the fields to be displayed in the report from the dropdown list.

All Asterisk (*) marked fields are mandatory.

6. Under the Notifications section, enter or select the field information as shown.

# Notifications

* Email Recipient Department v

* Report Format ® Email Content CSV Attachment

The following table describes the fields under the Notifications section:

*Email Recipient Select the email recipient from the dropdown list.

*Report Format Select the required checkbox to send the report as:
» Email content - The report will be sent as Email content.
or

+ CSV Attachment - The report will be sent as a separate attachment in
CSV format.

Copyright © 2021 AppViewX, Inc. All Rights Reserved. 14



Certificate Expiry Workflows

Note: Email Content is the default selection.

All Asterisk (*) marked fields are mandatory.

7. Click Submit.
» Get Expiry Certificates task completed.

L#]

~ —

k| =

T et Expiry Centificates
F

« Email natification received individually for expiring certificates.

Copyright © 2021 AppViewX, Inc. All Rights Reserved.
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Certificate Expiry Workflows

Certificate Expiry Notification - Cert Group Hierarchy

This workflow allows you to send a certificate expiry report notification to the certificate group and its

associated hierarchical groups.

To trigger this workflow:

1. On the Workflow Request page, from the navigation menu on the left, select View/Run.

The workflow Catalog page is displayed.
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2. On the Catalog page, under Certificate Lifecycle Automation catalog, click
3. From the options displayed, select Full View.
4. In the Certificate Lifecycle Automation window, under the Alert and Notification category, hover

your mouse over the Certificate Expiry Notification - Cert Group Hierarchy workflow and click rl

Copyright © 2021 AppViewX, Inc. All Rights Reserved. 16



Certificate Expiry Workflows
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6 Tip: You can also search for the workflow by typing the workflow name in the search bar.

The workflow is executed with the workflow inputs requested at the first stage.
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5. Under the Certificate Expiry section, enter or select the field information as shown.
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Certificate Expiry Workflows

» Certificate Expiry

* Time Frame Type

* Expiry Time Period

Report Fields

Exact v

oy
(U

Mone Selected -

The following table describes the fields under the Certificate Expiry section:

*Time Frame Type

Enter the time frame type from the available options:

» Exact - The system generates a report of certificates that expire on
exactly the number of days as mentioned in the expiry time period
starting from today. For example, if you mention 30 in the Expiry Time
period on the 1st day of the month, the report will contain details of
certificates expiring on the 30th day of the month.

* Range - The system generates a report of certificates that expire within
a range of days as mentioned in expiry time period. For example, if the
range is mentioned as 30-60 on the 1st day of the month, the system
generates a report of certificates expiring from 30th day to 60th day

from that day.

*Expiry Time Period

Enter the expiry time period for which notification has to be sent. Multiple

values can be entered, separated by commas. You can either define it

as an exact number or a range or a combination of both. For example,

30,60,90 or 0-30,30-60,0-60 or 30,30-60,90.

* Input type: Range - The expiry report will be generated for the range
specified. For example, 0 - 30 days, 0 - 60 days, 0 - 90 days.

« Input type: Exact - The expiry report will be generated for certificates
expiring on the exact specified date. For example, certificates expiring
on the 30th, 60th, 90th day.

Report Fields

Select the fields to be displayed in the report from the dropdown list.

All Asterisk (*) marked fields are mandatory.

Copyright © 2021 AppViewX, Inc. All Rights Reserved. 18



Certificate Expiry Workflows

6. Under the Notifications section, enter or select the field information as shown.

» MNotifications

* Notify Parent Group ® On Off

* Report Format ® Emnail Content CSV Attachment

The following table describes the fields under the Notifications section:

*Notify Parent Group Select On if a notification has to be sent to the parent group of the
certificate group.

Select Off if a notification is not required to be sent to the parent group of
the certificate group.

[ Note: On is the default selection. ]

*Report Format Select the required checkbox to send the report as:
« Email content - The report will be sent as Email content.
or

+ CSV Attachment - The report will be sent as a separate attachment in
CSV format.

[ Note: Email Content is the default selection. ]

All Asterisk (*) marked fields are mandatory.

7. Click Submit.

Copyright © 2021 AppViewX, Inc. All Rights Reserved. 19



» Get Expiry Certificates task completed.

Certificate Expiry Workflows

Get Expiry Certificates

0000

Ly - Gt Empiry Cortificatan

« Email notification received.

Certificate Expiring in 30 Days inbox =

supportappviews.com

tameo -

appviewX Notification

Reguest 10: 585 | Workflow Mame: Cerificate Expiry Mofificatian - Cert Group Hisrarchy

please fnd the folowing expirying cerificate of the group - Default

Thariks.

Ao

Please do ral reply as this is an asta generated email by AppWiewk

ﬁ certificate_expiry_... '

Certificate Expiry Notification - Days

This workflow enables you to generate a report listing certificates expiring in a specific number of days to

the email addresses present in the certificate or certificate group.

To trigger this workflow:;

Copyright © 2021 AppViewX, Inc. All Rights Reserved.
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Certificate Expiry Workflows

1. On the Workflow Request page, from the navigation menu on the left, select View/Run.

The workflow Catalog page is displayed.
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2. On the Catalog page, under Certificate Lifecycle Automation catalog, click

3. From the options displayed, select Full View.

4. In the Certificate Lifecycle Automation window, under the Alert and Notification category, hover

your mouse over the Certificate Expiry Notification - Days workflow and click |

Certificate Expiry Notrfcation « Devioes | Ser

: Certificate Expiry Netification - Dy P.El o]
~
[o Tip: You can also search for the workflow by typing the workflow name in the search bar.
J
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Certificate Expiry Workflows

The workflow is executed with the workflow inputs requested at the first stage.
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5. Under the Certificate Expiry section, enter or select the field information as shown.

# Certificate Expiry

&

* Expiry Time Period

Report Fields Mone Selected -

The following table describes the fields under the Certificate Expiry section:

*Expiry Time Period Enter the expiry time period for which natification has to be sent. Multiple

values can be entered, separated by commas. You can either define it

as an exact number or a range or a combination of both. For example,

30,60,90 or 0-30,30-60,0-60 or 30,30-60,90.

* Input type: Range - The expiry report will be generated for the range
specified. For example, 0 - 30 days, 0 - 60 days, 0 - 90 days.

* Input type: Exact - The expiry report will be generated for certificates
expiring on the exact specified date. For example, certificates expiring on
the 30th, 60th, 90th day.

Copyright © 2021 AppViewX, Inc. All Rights Reserved. 22



Certificate Expiry Workflows

Report Fields

Select the fields to be displayed in the report from the dropdown list.

All Asterisk (*) marked fields are mandatory.

. Under the Notifications section, enter or select the field information as shown.

» Notifications

* Email Recipient MNone Selected

* Report Format @ Email Content () CSV Attachment

The following table describes the fields under the Notifications section:

*Email Select the required recipient of the notification. You can select:

Recipient * Select all

« Certificate Email - The notification will be sent to the email addresses associated
with the certificate.

« Certificate Group Email - The natification will be sent to the entire certificate group
to which the certificate belongs.

*Report Select the required checkbox to send the report as:

Format « Email Content - The report will be sent as Email content.

or

+ CSV Attachment - The report will be sent as a separate attachment in CSV format.

[ Note: Email Content is the default selection. j

All Asterisk (*) marked fields are mandatory.

7. Click Submit.

Copyright © 2021 AppViewX, Inc. All Rights Reserved. 23



Certificate Expiry Workflows

» Get Expiry Certificates task completed.

—o—0—0 (v

Get Expary Certificates

Logga - Gt Expiiry Cortificaten

» Email notification received with Certificate Expiry Alert for each expiring certificate.

testoob_94602.appviewx.net - Certificate Expiring in 30 Days e« & @
SUpper@appyiews.com ZALPM (18 minutes age) gy &
Alert - Certificate Expiry
testoob_9602 appviewx.net - Expires in 30 Days
Group Default
Issuar CA ApaViowi

Commen Hame N
Serial number N Irkzlceed

Expiring In 30 Days

Piease: e nok reply a5 11z 15 an ate gencrated cmal, Powesnd Dy Appyiow,

Certificate Expiry Notification - Devices | Servers

This workflow enables you to generate an expiry report of certificates present on a device and expiring in

a specific number of days.

To trigger this workflow:

Copyright © 2021 AppViewX, Inc. All Rights Reserved. 24



Certificate Expiry Workflows

1. On the Workflow Request page, from the navigation menu on the left, select View/Run.

The workflow Catalog page is displayed.
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2. On the Catalog page, under Certificate Lifecycle Automation catalog, click

3. From the options displayed, select Full View.

4. In the Certificate Lifecycle Automation window, under the Alert and Notification category, hover

your mouse over the Certificate Expiry Notification - Devices | Servers workflow and click rl.

Certificate Lifecycle Automation (12)

Coetificane Expiry Notification - Devices | Sena ﬁ [o]

Cartificabe npiry Motification - Days Buf

~
[0 Tip: You can also search for the workflow by typing the workflow name in the search bar.

J
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Certificate Expiry Workflows

The workflow is executed with the workflow inputs requested at the first stage.
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5. Under the Certificate Expiry section, enter or select the field information as shown.

# Certificate Expiry

* Time Frame Type Exact v
* Expiry Time Period
* Device Category Select v
* Device Vendor

Device Name Mone Selected -

Report Fields Mone Selected -

The following table describes the fields in the Certificate Expiry section:

Copyright © 2021 AppViewX, Inc. All Rights Reserved.
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Certificate Expiry Workflows

*Time Enter the time frame type from the available options:

Frame » Exact - The system generates a report of certificates that expire on exactly the number

Type of days as mentioned in the Expiry Time Period starting from today. For example, if you
mention 30 in the Expiry Time period on the 1st day of the month, the report will contain
details of certificates expiring on the 30th day of the month.

» Range - The system generates a report of certificates that expire within a range of days
as mentioned in Expiry Time Period. For example, if the range is mentioned as 30-60
on the 1st day of the month, the system generates a report of certificates expiring from
30th day to 60th day from that day.

[ Note: Exact is the default selection. ]

*Expiry
Time Enter the expiry time period for which notification has to be sent. Multiple values can be
Period entered, separated by commas. You can either define it as an exact number or a range or

a combination of both. For example, 30,60,90 or 0-30,30-60,0-60 or 30,30-60,90.

« Input type: Range - The expiry report will be generated for the range specified. For
example, 0 - 30 days, 0 - 60 days, 0 - 90 days.

* Input type: Exact - The expiry report will be generated for certificates expiring on the
exact specified date. For example, certificates expiring on the 30th, 60th, 90th day.

*Device [Select the device category for the report from the dropdown list.
Category

*Device [Select the device vendor for the report from the dropdown list.
Vendor

Device | Select the specific device for the report.
Name

Report Select the report fields to be displayed in the report from the dropdown list.
Fields

All Asterisk (*) marked fields are mandatory.

6. Under the Notifications section, enter or select the field information as shown.

Copyright © 2021 AppViewX, Inc. All Rights Reserved. 27



Certificate Expiry Workflows

# Notifications

* Email ID 0]
CC Email ID @
* Report Format ® Email Content CSV Attachment

The following table describes the fields in the Notifications section:

*Email ID | Enter the email address of the recipient in the ‘To’ field. Comma separated values can
be entered for multiple email addresses.
[ Note: The email id of the logged in user is populated automatically. ]
CC Email | Enter the email address of the recipient in the ‘CC’ field. Comma separated values can
ID be entered for multiple email addresses.
*Report Select the required checkbox to send the report as:
Format + Email Content - The report will be sent as Email content.

or

* CSV Attachment - The report will be sent as a separate attachment in CSV format.

[ Note: Email Content is the default selection.

J

All Asterisk (*) marked fields are mandatory.

7. Click Submit.

Copyright © 2021 AppViewX, Inc. All Rights Reserved.
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Certificate Expiry Workflows

» Get Expiry Certificates task completed.
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Certificate Expiry Workflows
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Certificate Expiry Notification

This workflow enables you to generate a report listing certificates expiring in a specific number of days

and notify the recipients via email. You can also mention email addresses of the recipients who need to

be informed additionally in CC mails.

To trigger this workflow:

1. On the Workflow Request page, from the navigation menu on the left, select View/Run.

The workflow Catalog page is displayed.
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2. On the Catalog page, under Certificate Lifecycle Automation catalog, click

3. From the options displayed, select Full View.
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4. In the Certificate Lifecycle Automation window, under the Alert and Notification category, hover

your mouse over the Certificate Expiry Notification workflow and click xl

rrcate Expirg Moofication - Devices | Ser
» Cartieate Expiry Hotification - Diyi
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-

Cerificaie Eapiry Hotification D |

» Certiicate Bapiry Motfication based on Cirtie. | Run

= Enncll Cemificace Based on Polcy | CSR Deta
= Enroll Cemificate with Certificate Group and

& Eagy Corificane Pronvinicniog

* Orphan Certificates Report

* Certicite Eepiry Motification with Serviceld

= Cenicae Expiry Monficagon with IRA

~
0 Tip: You can also search for the workflow by typing the workflow name in the search bar.
J
The workflow is executed with the workflow inputs requested at the first stage.
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5. Under the Certificate Expiry section, enter or select the field information as shown.
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A Certificate Expiry

* Expiry Time Period 0,

Report Fields Mone Selected -

The following table describes the fields under the Certificate Expiry section:

*Expiry Time Period
Enter the expiry time period for which notification has to be sent. Multiple

values can be entered, separated by commas. You can either define it
as an exact number or a range or a combination of both. For example,
30,60,90 or 0-30,30-60,0-60 or 30,30-60,90.

* Input type: Range - The expiry report will be generated for the range
specified. For example, 0 - 30 days, O - 60 days, 0 - 90 days.

 Input type: Exact - The expiry report will be generated for certificates
expiring on the exact specified date. For example, certificates expiring
on the 30th, 60th, 90th day.

Report Fields Select the fields to be displayed in the report from the dropdown list.

All Asterisk (*) marked fields are mandatory.

6. Under the Notifications section, enter or select the field information as shown.

# Notifications

* Email ID G
CC Email ID 0]
* Report Format ® Email Content CSV Attachment

The following table describes the fields under the Notifications section:
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*Email ID | Enter the email address of the recipient in the ‘To’ field. Comma-separated values can be

entered for multiple email addresses.

CC Email | Enter the email address of the additional recipients in the ‘CC’ field. Comma-separated

ID values can be entered for multiple email addresses.

*Report | Select the required checkbox to send the report as:
Format » Email Content - The report will be sent as Email content.

or

* CSV Attachment - The report will be sent as a separate attachment in CSV format.

[ Note: Email Content is the default selection. ]

All Asterisk (*) marked fields are mandatory.

7. Click Submit.
» Get Expiry Certificates task is executed.

L#]

(u—a—0—av

Get Explry Certificates

Loggs - Gt Expiry Cortificaten
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« Email notification received with report as email content.
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Update Certificate Attributes

This workflow allows you to update the certificate attributes in bulk.

To trigger this workflow:

1. On the Workflow Request page, from the navigation menu on the left, select View/Run.
The workflow Catalog page is displayed.
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2. On the Catalog page, under Certificate Lifecycle Automation catalog, click

3. From the options displayed, select Full View.

4. In the Certificate Lifecycle Automation window, under the Alert and Notification category, hover

your mouse over the Update Certificate Attributes workflow and click rl.

o Updste Certficate Altribates

= Easy Cortificate Proviuoning

Erwoll Certificans Buatsed on Pobcy | C58 Deta.

Erecll Cartificane with Demflcane Group and

~
[ Tip: You can also search for the workflow by typing the workflow name in the search bar.
J
The workflow is executed with the workflow inputs requested at the first stage.
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— )

A Aboar thin Warkflow

A Cartificate Filter

The following table describes the fields in the Certificate Filter section:

*Certificate Filter Choice

Select the required checkbox to fetch

« All certificates

[ Note: This is the default selection.

* Based on Criteria

Note: Selecting this option will fetch certificates based on
criteria such as certificate group and certificate category.

*Certificate Group

Select the appropriate certificate group from the dropdown list.

Note: This field is displayed only when you select the Based on
Criteria option in Certificate Filter Choice.

*Certificate Category

Select the appropriate certificate category from the dropdown list.

Note: This field is displayed only when you select the Based on
Criteria option in Certificate Filter Choice.

|
|
|
|
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All asterisk (*) marked fields are mandatory.

5. Click Submit.

Fetch Certificates task is executed.

L#]

| Fetch Certificates

6. Select the appropriate option for downloading the file as a CSV or Excel file.

The file is downloaded to your device.

L#]

— e —B v

A Samphs §ie Dommiboesd

. Fila Uplaad

7. Once you have updated the certificate attributes in the downloaded file, under File Upload, click = to

upload the modified file.
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L]
+ -  Sampe e Beuriead

& ke Wpload

8. Click Next
9. In the Confirmation pop-up window, click Ok.

» Update Certificate Attributes task in progress.

()

s

Update Certificate Attribute

Update Cenificate Alribute

Logs - Update Cartificats Attribute

o Logn Fossrad

» Update Certificate Status is displayed. To download this list, from the top right corner of the screen,

click & .
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« Email notification sent successfully.

=000 00 -
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» Email with report received.
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Certificate Expiry Notification with JIRA

This workflow allows you to create a JIRA incident ticket for certificates expiring in a specific number of

days.

To trigger this workflow:

1. On the Workflow Request page, from the navigation menu on the left, select View/Run.

The workflow Catalog page is displayed.
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2. On the Catalog page, under Certificate Lifecycle Automation catalog, click

3. From the options displayed, select Full View.

4. In the Certificate Lifecycle Automation window, under the Incident Automation category, hover

your mouse over the Certificate Expiry Notification with JIRA workflow and click rl.

= Cerificate Expiry Mod B ation baded on Lerll

Oiphasn Coetificanss Repor

Update Certificate Aftributes

Cortificate Expiry Notrsation with SeraceN

CRrTIfcate Expiny NOTICATION with JIRA 5 @
Bun

Enroll Certficate Based on Policy | O3 Deta

~
[ Tip: You can also search for the workflow by typing the workflow name in the search bar.
J
The workflow is executed with the workflow inputs requested at the first stage.
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5. Under the Incident Ticket section, select the field information as shown.

A Incident Ticket

* Ticket Creation Type

* JIRA Account

* Ticket Type

* JIRA Project

® Individual Bulk

JIRA v @
® Bug () Task @
TEST @

The following table describes the fields in the Incident Ticket section:

*Ticket
Creation
Type

High.

Select Ticket Creation Type as:
« Individual - A separate ticket will be created for each certificate.
* Bulk - A single ticket will be created for all the expiring certificates as per the category.

The categories can be configured based on the ticket priority as Low, Medium and

[ Note: Individual is the default selection. ]
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*JIRA Select the JIRA Account as configured in the Integration Hub from the options available
Account |in the dropdown.

[ Note: JIRA is the default selection. j

*Ticket Select the type of ticket with reference to the project:

Type » Bug - This will indicate that the ticket is for a bug in the project.
» Task - This will indicate that the ticket is for a task in the project.

[ Note: Bug is the default selection. ]

*JIRA Enter the name of the project for which ticket(s) have to be raised.

[ Note: Test is the default selection. ]

All Asterisk (*) marked fields are mandatory.

Project

. Under the Low - Set Incident ticket Priority section, enter a value (number of days) for tickets with

low priority. For example, for certificates expiring in 90 days, incident priority can be low.

. Under the Medium - Set Incident ticket Priority section, enter a value (humber of days) for tickets

with medium priority. For example, for certificates expiring in 60 days, incident priority can be medium.

. Under the High - Set Incident ticket Priority section, enter a value (number of days) for tickets with

high priority. For example, for certificates expiring in 30 days, incident priority can be high.

. Under the Description Fields section, select certificate attributes from the dropdown that will be

displayed in the JIRA issue description.

Note: This is a mandatory field. Multiple certificate attributes can be displayed by selecting the
checkbox of the attribute name.

Click Submit.
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+ JIRA ticket creation Summary.
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« Ticket created on Jira.
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Certificate Expiry Notification with ServiceNow

This workflow allows you to create a ServiceNow incident ticket for certificates expiring in a specific

number of days.

To trigger this workflow:
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1. On the Workflow Request page, from the navigation menu on the left, select View/Run.

The workflow Catalog page is displayed.
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2. On the Catalog page, under Certificate Lifecycle Automation catalog, click

3. From the options displayed, select Full View.

4. In the Certificate Lifecycle Automation window, under the Incident Automation category, hover

your mouse over the Certificate Expiry Notification with ServiceNow workflow and click xl

~
[e Tip: You can also search for the workflow by typing the workflow name in the search bar.
J
The workflow is executed with the workflow inputs requested at the first stage.
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5. Under the Incident Ticket section, select the field information as shown.

A Incident Ticket

* Ticket Creation Type ® Individual Bulk

* ServiceMow Account CHANGE

The following table describes the fields in the Incident Ticket section:

Medium and High.

*Ticket Select Ticket Creation Type as:
Creation + Individual - A separate ticket will be created for each certificate.
Type » Bulk - A single ticket will be created for all the expiring certificates as per the

category. The categories can be configured based on the ticket priority as Low,

[ Note: Individual is the default selection.

Account options available in the dropdown.
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Note: Change is the default selection.

All Asterisk (*) marked fields are mandatory.

6. Under the Low - Set Incident ticket Priority section, enter a value (number of days) for tickets with

low priority. For example, for certificates expiring in 90 days, incident priority can be low.

7. Under the Medium - Set Incident ticket Priority section, enter a value (number of days) for tickets

with medium priority. For example, for certificates expiring in 60 days, incident priority can be medium.

8. Under the High - Set Incident ticket Priority section, enter a value (humber of days) for tickets with

high priority. For example, for certificates expiring in 30 days, incident priority can be high.

9. Under the Description Details section, select multiple certificate attributes from the dropdown that will

be displayed in the ServiceNow description.

[ Note: This is a mandatory field.

J

10. Click Submit.

« Incident Creation Summary
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« Incident ticket created on ServiceNow.
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Orphan Certificates Report

This workflow enables you to generate a report on certificates that are present on a device but not
associated with any application or profile.

To trigger this workflow:

1. On the Workflow Request page, from the navigation menu on the left, select View/Run.
The workflow Catalog page is displayed.
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2. On the Catalog page, under Certificate Lifecycle Automation catalog, click

3. From the options displayed, select Full View.

4. In the Certificate Lifecycle Automation window, under the Report category, hover your mouse over

the Orphan Certificates Report workflow and click el

~
[6 Tip: You can also search for the workflow by typing the workflow name in the search bar.
J
The workflow is executed with the workflow inputs requested at the first stage.
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5. Under the Device Information section, enter or select the field information as shown.

# Device Information

* Category Select v
* Vendor Se v
Mame None Selected -
Device Certificate Fields None Selected -

The following table describes the fields in the Device Information section:

*Category Select the device category for the report from the options available in the
dropdown.

*Vendor Select the device vendor for the report from the options available in the
dropdown.

Name Select the specific device for the report.
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Device Certificate
Fields

Select the report fields to be displayed in the report from the dropdown list.

All Asterisk (*) marked fields are mandatory.

6. Under the Notifications section, enter or select the field information as shown.

# Notifications

* Email ID 0]
CCEmail ID @
* Report Format ® Email Content CSV Attachment

The following table describes the fields in the Notifications section:

*Email ID | Enter the email address of the recipient in the ‘“To’ field. Comma separated values can
be entered for multiple email addresses.
[ Note: The email id of the logged in user is populated automatically. j
CC Email | Enter the email address of the recipient in the ‘CC’ field. Comma separated values can
ID be entered for multiple email addresses.
*Report Select the required checkbox to send the report as:
Format * Email Content - The report will be sent as Email content.

or

» CSV Attachment - The report will be sent as a separate attachment in CSV format.

[ Note: Email Content is the default selection.

J

All Asterisk (*) marked fields are mandatory.

7. Click Submit.
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Certificate Expiry Workflows
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« Email notification received with report as email content.
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Chapter 5: Certificate Expiry Notification task

You can design a custom workflow for receiving certificate expiry notifications using the prebuilt task
for getting expiry certificates available in the Workflow Studio. The OOB script task for getting expiry

certificates can be found under Certificates, in the Expiry folder in the Workflow Studio.
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= appviewX

master v Workflow  Rgj

Cert expiry

Q, Search by tag, task
et v e ﬂ
<[5 Get Expiry Certificates

Source Control
General
Change Management

User interface

Notification

Application Delivery

IPAM
ITSM
Certificates
CLM Automation

Expiry

Utils
DevOps
GitOps
Reports
Network

Solutions

Utilities

To design a custom workflow using the Get expiry certificates task
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1. To access the navigation pane, hover the mouse over = .
2. From the menu displayed, click Studio > Workflow.

The Workflow inventory page is displayed.
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3. On the Workflow inventory page, click Design.
4. Enter a suitable Name for the workflow.
5. Click Save.
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Certificate Expiry Notification task

= appviewX

A master v  Workflow  Rollback

* Name expiry_task_demo

Description
Category Default v +
Subcategory Default v +

Save Cancel

Workflow  Rommac P Freview: Clssic B @ @ Varabls Mapping
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This task can be used to generate a report listing certificates due to expire in a specific number of
days.

Copyright © 2021 AppViewX, Inc. All Rights Reserved. 58



Certificate Expiry Notification task
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7. To auto-generate a form for this workflow, click Form above the Start task.

= appviewX
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% eupiry task demo
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8. Click above the Get Expiry Certificates task to auto-populate the form fields.
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Certificate Expiry Notification task
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9. Select the fields required in the input form.

10. Provide a Form Name and click Create.
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11. To display the certificate data in a report, from the Utils folder, drag and drop the Visualize Certificate

Expiry Report prebuilt subflow.
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Certificate Expiry Notification task
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This subflow includes User Interface tasks such as Grid and Chart (Pie chart and Stacked bar chart).
The report generated will be displayed as a grid or a chart based on the inputs provided in the input
form.
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12. To get a preview of the user input form, connect all the workflow tasks and click Preview.
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Certificate Expiry Notification task
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User Inputs form is displayed.
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The following table describes the field information in the User Inputs form:

Time
Frame
Type

Enter the time frame type from the available options:
» Exact - Allows you to enter the exact value for the expiry time period (30 days).
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* Range - Allows you to give a range for the expiry time period (0 - 30).
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Certificate Expiry Notification task

Note: Exact is the default selection.
Expiry Enter the expiry time period for which natification has to be sent. Multiple values can be
Time entered, separated by commas. You can either define it as an exact number or a range
Period or a combination of both. For example, 30,60,90 or 0-30,30-60,0-60 or 30,30-60,90.
* Input type: Range - The expiry report will be generated for the range specified. For
example, 0 - 30 days, O - 60 days, O - 90 days.
« Input type: Exact - The expiry report will be generated for certificates expiring on the
exact specified date. For example, certificates expiring on the 30th, 60th, 90th day.
Field Select the field from the options available in the dropdown.
Operator | Select the conditional operator:
K]
* Is Not
Value Enter a valid value for filtering the certificates.
Additional | This grid displays the values selected in these fields:
Filters * Field
» Operator
* Value
[ Note: The steps to apply these additional filters are given below the table. j
Report Select the format in which the report is displayed from the available options:
Format * Default
+ Pie Bar Chart
« Stacked/Bar Chart
Report Select the fields to be displayed in the report from the options available in the dropdown.
Fields

13. To add filters to the Additional Filters grid, click .

14. To edit the value of a particular filter, select the filter in the grid and click n

15. Enter the new value(s) for the filters (Field/Operator/Value) and click n again to update the

value(s).

Copyright © 2021 AppViewX, Inc. All Rights Reserved. 63



Certificate Expiry Notification task

16. To delete a filter, select the filter in the grid and click l:.
17. To maximize the Additional Filters grid, from the top right corner of the grid, click
18. Click Next.

Report generated with expiry certificates data displayed in Grid format.

el rearmb s CA Commen Nams ]

L

Note: For more information on how to design custom workflows in the Workflow Studio, refer

to the Visual Workflow User Guide.
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Chapter 6: Scheduling an OOB workflow

You can also schedule these OOB workflows to be triggered at specific time intervals (once or repeat

daily, weekly, monthly, yearly) as per your requirement.

[ Note: For more information on scheduling workflows, refer to the Visual Workflow User Guide. ]
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